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Say Cheese! 
Is your LinkedIn profile picture helping or hindering the success of your LinkedIn profile?  
 
LinkedIn has stated that users with profile pictures have 7 times more views to their profile 
than users without a photo. By including a photo, you are showing the world that you are a 
serious LinkedIn user and networker. Think about it, would you trust a profile without a profile 
picture? You would wonder if it’s a genuine profile. You may even assume that the person may 
be hiding something. A professional photo shows your reader that there is a real person behind 
the profile and that you mean business!  
 
Profile photos are not just relegated to just your profile. When your profile appears in search 
results, your smiling mug peers out from next to your name and subliminally implores your 
reader to, “Read all about me!” Profile Photos also appear along with your LinkedIn Group 
messages, Network Updates, recommendations and more!  
 
Because your profile is used in so many places, it really is your digital stand-in. If you get right 
down to it, you are your profile picture. This is your calling card and your online identity. It’s 
imperative that you look good. Don’t worry if you aren’t a supermodel! It’s not important that 
you look gorgeous but it is imperative that you look friendly, well-adjusted, and professional.  
 

Determining If You Need a New Profile Picture 
Most people are under the incorrect notion that their Profile Picture is good enough. There is 
no such thing as a “good enough” profile picture! When it comes to a profile picture, you want 
to hit it out of the ballpark! You want absolutely the best results.   
 
On the following page is a quiz to determine if you need a new profile picture. Open your 
LinkedIn profile and look at your profile picture as you take this quiz. Please be as objective as 
possible. Answer either yes or no to each question.  If there is a long drawn out explanation to a 
question, simply mark it as a Yes answer.   
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Profile Quiz 

 
Is your profile picture over 2 years old?  
___ Yes   ___ No 
 
Was your profile picture snapped at a wedding or family gathering?  
___ Yes   ___ No 
 
Does your profile picture contain another person other than just yourself?   
___ Yes   ___ No 
 
Are there remnants of another person cropped out of your profile picture?  
___ Yes   ___ No 
 
Are there animals in your profile picture? 
___ Yes   ___ No 
 
Are you wearing a hat or sunglasses in your profile picture? 
___ Yes   ___ No 
 
Is your profile picture of a cartoon character, business logo, symbol or artistic representation? 
___ Yes   ___ No 
 
Can you easily discern the background of your profile photo? 
___ Yes   ___ No 
 
Are you looking up or down or away from the viewer? Are you not making eye contact? 
___ Yes   ___ No 
 
Is the quality of the image grainy or dark? 
___ Yes   ___ No 
 
Do you look menacing or unfriendly? Are you not smiling?  
___ Yes   ___ No 
 
Are you wearing a t-shirt, bathing suit, or jeans in your profile picture? 
___ Yes   ___ No 
 
Can you see your elbows or knees in your profile picture? 
___ Yes   ___ No 
 
Did you have someone other than a professional photographer take your profile photo? 
___ Yes   ___ N0 
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Quiz Results 

If you answered yes to any of the questions above, YOU NEED A NEW PROFILE PHOTO. Even if 
you answered no to all the questions above, you still may need a new profile photo.   
 
A POWERFUL LinkedIn profile photo is cropped, centered, and recently taken. The image is not 
too dark, grainy, or taken from afar. There should only be one person in it- you! Most 
importantly, you are the focus of the photograph and the image spotlights you as a 
professional!  
 
The best way to achieve these results is by working with a professional photographer.  
 
A professional photographer has the right equipment and a trained eye. Professional 
photographers can make just about anyone look presentable. And the real secret is... most 
professional photographers are quite affordable! Remember, this is an investment into your 
future and it’s worth spending money to make yourself look your best.  
 
I know it’s hard for busy professionals to find the time to schedule a session with a 
photographer. As tempting as it might be to ask the photographer to come to your office, resist 
that urge. Go to their studio where they have professional lighting and attractive backgrounds.  
 
I once asked a photographer to come to my office for a photography shoot.  The photographer 
arrived with just his camera and no lighting.  The images that resulted were not great.  Good 
lighting is typically what makes or breaks a good photograph.   

Finding the Right Photographer 
The right photographer is most likely just down the street from you! All you need to do is an 
Internet search. You can use Google, Bing, Yelp, or many other online directories.  

How to Google a Photographer 

1. Open your browser and go to maps.google.com 
2. Locate your home or office address… this is for a proximity search so determine to 

which address you want the photographer to be closest.  
3. Choose Search Nearby and search for Photographer. 

 
Google will return a list of photographers that are nearby your starting address. These results 
will contain the address, telephone number, and Website of the photographer. It’s very 
important that you check out their Website and look at examples of their work. As you peruse 
their online portfolio, think in terms of the end results. Are you impressed with their work? Are 
there good examples of business headshots they’ve already taken?  The photographer may do 
impressive work with brides and children but that doesn’t mean they can do a professional 
headshot well.   
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Getting Recommendations from Friends 

You can also ask your friends to recommend a photographer. However, when asking friends, 
you may find that a friend is an amateur photographer and would love to help you out. I must 
caution you against using a friend or loved one as a photographer. First off, you get what you 
pay for and when it’s free or cheap, you don’t get much. Secondly, when the other person is 
doing something out of the goodness of their heart, the motivation isn’t there to do it quickly or 
with the utmost quality. Third, there’s a reason why it’s a hobby and not a trade they are doing 
professionally (BECAUSE THEY AREN’T GOOD ENOUGH AT IT!). Please resist going the cheap 
route! 

Sears or Walmart Photography 

I have had a number of clients who have chosen to go the Sears or Walmart photographer 
route. In almost every case, the quality of the resulting headshot is embarrassingly bad. You’ve 
seen it before… the background is of clouds or bamboo trees.  The person is sitting on a stool 
and they are using their fist as a chin rest.  This type of portraiture does not convey the image 
of a top notch professional.     
 
Most surprisingly is that when all is said and done, the resulting session costs about the same as 
an independent photographer.  

Qualifying the Photographers 

Once you get a list of 2 or 3 local photographers, you want to call each individually and ask 
them a few questions: 
 

 Do you have experience taking professional business headshots?  

 Do you have an actual studio with lighting?  

 What kinds of backgrounds do you use? Do you have a plain white or pale color 
background? 

 Are you familiar with taking pictures for use on the Internet? 

 Do you use Photoshop to freshen up the image?  

 Will you be able to provide me both high res and low res images at specific dimensions 
and file formats?  

 What are your business hours? Do you schedule sessions after regular business hours?  

 How much do you charge for a session?  

 How long is a session?  

 How many images can I choose in the included price?  

 Do you charge to touchup the image? 

 How much for extra images? 
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The most important thing is to determine if the photographer is a person with whom you feel 
comfortable talking to and whether you can work well together. The truth is you are not going 
to be in your element during the session and the likelihood of you feeling uncomfortable is very 
high. It’s important that you choose a photographer that will put you at ease and make the 
situation as comfortable for you as possible.  

Photography Rates 

Photography rates vary by region. A photographer in New York City is going to cost more than a 
similar photographer in Tupelo, Mississippi. Photography is a creative service and most 
photographers set their price by their reputation. Most often, the better the photographer, the 
higher the rate.  
 
You can expect to pay somewhere in the ballpark of $100.00 – $300.00 a session. You may then 
have to pay extra for the actual retouched photo or any additional shots. In some instances, 
you can expect to pay even more than that. I once spoke to a photographer that charged well 
over a $1,000 for a session. She may have charged a lot but she pretty much guaranteed you 
would get an amazing portrait that conveys your professional brand and truly impresses.   
 
You may find that you can obtain a photographer at a much lower cost. In this situation, do 
make sure you get examples of their work before booking them. I’ve said it before and I’ll say it 
again, you get what you pay for!  

What to Wear 
I don’t have to tell you that what you wear is very important. Luckily, a headshot is mainly just 
your head so what you wear on the bottom isn’t as important as what you wear on the top. 
Make sure whatever you choose fits well in the shoulders and neck since that is what will show 
in the photo. Do not expose much in the way of skin. No cleavage, ladies! Or gentlemen, for 
that matter.  
 
When deciding on what to wear, think about what you would wear to a client meeting or a job 
interview. If you work at a casual, informal workplace, it may not be out of place for you to 
choose a more casual outfit. I am reminded of something my mother once told me when I was 
starting out in my career, “Don’t dress for the job you have, Donna, dress for the job you want!” 
So although your office environment is a casual one, you still may decide to opt for a more 
formal business picture. Especially if you have higher aspirations for your career.  
 
I highly suggest bringing 2 or 3 different outfits with you to your session. Often times what 
looks nice in person, doesn’t translate well to a photograph. My suggestion is to keep things 
simple.  Go with neutral colors or varying tones of black.  Skip the ruffled shirts or crazy prints.  
Choose ties with simple patterns and only a couple of colors.   
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Getting Ready for the Big Day 
Getting your hair professionally coifed on the day of your photography session is a good idea. 
Don’t get it cut the day of your session but do get it styled. You want to avoid that “just cut” 
look.  Ladies, you may want to visit a makeup artist if you are so inclined. Keep the makeup 
simple. You want to look elegant and classy.  Gentlemen, be careful with your razor! If you 
sport facial hair, make sure it’s freshly groomed.  There’s nothing wrong with a mustache, 
beard, or even mutton chops so long as they don’t look the result of a long stay on a deserted 
island.   
 
Get plenty of sleep the night before. Drink a lot of water. Try to schedule your session during a 
time when you are not going to get bogged down with a lot of stress or pressure. Saturday 
mornings are often a good time if you can find a photographer with flexible hours.  You may 
choose to take a morning off work to get the session done.  I once booked a photography 
session at the end of the day thinking I could get it done after work. The resulting pictures from 
that session showed a woman who was over-worked, harried, tired and not a happy camper. 
No matter how I smiled and tried to look calm, my inner nerves showed on my face. I ended up 
not buying a single image and having to reschedule the entire session.  
 

Working it for the Camera 

When you arrive at the studio, it’s important that you sit down and talk first with the 
photographer. Make sure they thoroughly understand the goal for the session. This isn’t a 
glamor shot you are after! You want a very professional, business headshot to be used on 
LinkedIn as your profile picture.  
 
Decide upon the backgrounds you will use for the photo. I highly suggest a white or pale color 
background. You do not want a noisy or busy background. No clouds or bamboo trees! The idea 
is that YOU are the focus of the portrait, not a busy background. Although my preference is for 
light backgrounds, I have often seen dark backgrounds look nice as well. Use your best 
judgment. Take into account the color of your outfit. If you are wearing white, a white 
background will look odd. Feel free to ask the photographer for their professional opinion. They 
do this for a living and will be able to guide you.  
 
Secondly, make sure there is lighting in the studio. If you are using a professional photographer, 
they should spend time making sure you are lighted properly. When the shooting commences, 
the camera should be around your eye level. You do not want shots taken at too low of an 
angle or too high of an angle.  
 
Move around a bit. Vary your expression. Think in your mind: CONFIDENCE, STRENGTH, 
FRIENDLINESS, PEACE, WARMTH, and HAPPINESS. Also, make eye contact. Don’t look away.  
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And smile! So many people seem to forget to smile in their photo and their excuse is they want 
to appear “serious.” That's all fine and dandy but more often than not, serious actually appears 
angry.  
 
Once you have strutted your stuff for about 15 minutes, ask the photographer to review the 
shots thus far taken. By checking the photos mid-session, you can see if what you are doing is 
working. It often takes hundreds of shots to finally find one that is usable. Don’t feel bad about 
this… you are a professional not a supermodel!  

Choosing the Right Photo 
It’s hard to see yourself objectively. When it comes time to choose the right photo, it’s often 
best to ask for help. Photographers will often provide you with a Website that hosts all the 
shots from your session. Share this link with a friend and ask for their assistance. Don’t just ask 
any friend. Make sure you choose a friend who is business-minded and not afraid to speak the 
truth. There have been a few times where I had to very gently tell a client that the pictures 
taken were not of the best quality and they needed to be retaken.  This is never a comfortable 
situation but it’s better to hear the truth than to upload a ridiculous looking profile picture that 
has people wondering if you are possibly insane.   
 
The picture you choose doesn’t have to be the one in which you look movie star glam but it 
should show you as a friendly, approachable, well-adjusted, PROFESSIONAL!  
 
Again, notice how I did not state “serious” or “corporate” as descriptors. I don’t want you 
looking dour or serious or even angry. People are not attracted to sourpusses! People do not 
want to work with people who seem sullen or uninterested.  
 
The final picture you choose should show a person who is likeable and professional.  
 

The Final Image 

Once you have chosen your final image, make sure the photographer gives it to you in a high 
res and low res format. The high res can be used for printing later, if needed. The low resolution 
is what you will eventually upload to LinkedIn.  
 
Ultimately, the final low res image needs to be in JPG, GIF or PNG file format. The image 
dimensions should be between a minimum of 200 by 200 pixels and a maximum of 500 by 500 
pixels. The maximum file size is 4 MB.  
 
If the photographer is unable to provide you the image within these constraints, all is not lost. 
You can always open the file in Paint or another image processor application and resize the shot 
yourself.  
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Resizing and Saving a Low Res Image 

1. All Programs > Accessories > Paint 
2. File > Open > locate the hi resolution image file 
3. Image > Resize… resize the image to 500 by 500 or as close as you can get. Do not skew 

the image! You must maintain its dimensions otherwise the image may elongate or 
widen.  

4. File > Save As > Save the image as a PNG.  

Touching Up 

The proverbial “airbrush” is a wonderful thing! If used properly, retouching can freshen you up 
and make a good photo even better. However, if used improperly, retouching can be a 
detriment. Retouching is best done minimally. Use it to hide dark circles but don’t zap away all 
of your crow’s feet. Use it to hide a zit but not to reduce the size of your nose. Remember, the 
final image needs to be of YOU! You don’t want to upload an image of a stranger.  
 
As an author and speaker, I have been on my fair share of photography shoots. I hate to admit 
this but more than once I have had to ask photographers to remove some of their retouching. 
You see, the goal of the photo is NOT to look like a perfect model. The goal is to look like a well-
adjusted professional. Getting rid of all flaws just makes you look less like yourself and more 
like an alien. Embrace who you are, wrinkles and all.  

 

Uploading Your Photo 
Now that you have your ideal headshot, it’s time to upload it to LinkedIn.  
 

1. Go to LinkedIn.com 
2. Profile > Edit Profile 
3. Locate the silhouetted picture LinkedIn uses as a space holder or your current 

profile picture.  
4. Click the “Edit” link located on the current image.  
5. You are now at the Photo Upload page. Click the “Choose File” button.  
6. A window will open where you can select your photo from your hard drive. Find 

your photo and click the “Open” button.  
7. Click the “Upload Photo” button to upload your image to LinkedIn.  

 
Once uploaded, LinkedIn displays a preview of your photo as others will see it. How does it 
look? Is your photo not centered correctly? Don’t worry about it! Do you see that yellow dotted 
square atop your photo? You can resize that square so it fits your face, neck, and the top of 
your shoulders. Do not zoom out too far! Your profile picture should not contain your elbows. 
LinkedIn will crop your photo along that yellow dotted line. When you are happy with your 
photo, click “Save Photo.” 
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You Look Marvelous, Darling!  

Congratulations!  By simply uploading a professionally taken photograph of yourself, you are 
showing the world that you are a business person who means business!  If anyone asks why you 
went above and beyond with your profile picture, tell them you value excellence in all areas of 
your professional life.   
 
You now have a professional headshot of yourself that you can use on your other Social Media 
profiles.  You can use it for Facebook, Twitter, Google Plus, or any other social networks where 
you have a profile.   
 
You can also use this photograph on your bio or for an event or project that requires a 
headshot.  Many of my clients tell me that they are amazed at how many different ways they 
are able to utilize their headshot.   

Examples of Good Profile Pictures 
Here are some examples of good profile pictures. You want your profile picture to be in this 
league.  
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Examples of Bad Profile Pictures 
A picture is worth a thousand words… so why do these profile pictures leave me speechless? 
 

 
 
 
 
 
 
 
 
 
Yes, these are profile pictures from actual LinkedIn users. If you find your picture amongst these 
bad examples, I am truly sorry.   
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Do’s and Don’ts 

 

DO DON’T 

 
 Have a professionally taken photo 

 

 
× Use an image of a cartoon, symbol, 

drawing, or any content other than an 
actual photograph of yourself. 

 
 Use a current photo, within 2 years 

 
 Look straight into the camera 

 

× Use an outdated photo over 2 years 
 

× Wear sunglasses or look away 

 Use a pale color / blank background 
 

× Have a distracting, busy background 
 

 Dress professionally 
 

× Wear a bathing suit 
 

 Zoom in, no elbows! It’s called a 
headshot for a reason  

× Use a full length shot or have others in 
the frame with you 

 

 
 
 

LinkedIn Profile Photo Guidelines 

 

 Your LinkedIn profile picture can be as 4MB in size  

 Supported file formats: JPG, GIF, and PNG. 

 Make sure your photo is at least 200 x 200 pixels and a maximum limit of 500 x 500 
pixels. 

 


